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Microsoft Access, is a Database Mam.agemeht
MS Access, also hml'-;f;:i combination of the relational Microsogy [,
System from mm hical user interface and ml:'twa_re-develupmm
Database Engine mﬁ.:f e eSOV it o applications, includeg i,
mb Itis fm editions and also comes =ib!=parahel.‘p'l-.”E 5
: : in i format on the Access Jg
L B o L e
applications “’d‘h:'? vnde range ;,f use, software developers and da,
MS Access ‘;ESA ccess to develop application software, and " power
architects can use Boild sdborare soplicati whm:asnmmalusercan_aise
B Al P b e e e T Oficeapplicatos
e : ad by Vi ic for Applications, an o ject-
] Ammﬂédl;:mﬂppﬂﬂ_eds mlﬁfs;:n re'EefreIr'ulze a variety of objects

'.'usedmiommandreportsexpﬁ::w::
* methods properties in the VBA programming environment, and
codemfulli ma}'duda:md call Windows operating-system functions.
5.2 Brief about Database '

~ Adatabase is a collection
itmdrelrlevei_thgnymy

of objects that allow you to store data, organize
 The first databases i during the 1960s and 1970s were
‘upon either ﬁmﬂﬂdﬂﬁhuﬂu}mchnl or networked data models. These
methods of storing data were relatively

ely inflexible due to their rigid structure
ot} selance on applications programs f perform even the nost routine
In the late 1

R . .:f" & # .
9705, the relation, al database model which originated in |

lementa L & MUty became available in comm:sj:ll

K e s that have some relationships among

4
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rional databases such a5 g

Sybase,
and MS Access, gy, is smredmi};\ ta]l;i Sracle, 163 DB2, Ms
(Access calls a column , g, dh <5 Made up of gne o
a single data type 5

chas B Ted in each, column
te etc. A collection of valy "f”-”tlmestalltd. ar string”

f L]
e table, 5 from each, umn of a table is called
t tables can have ihe same colym,
plicitly specify a relatic,

nship betye,
A in one table are shareg with an
ole, if YOou rum a Store,

le and an Invoices table,

s

LT

N In commgn,
T two tables,
other table,
YOu Would erpate 5 Customers table,
Then, when ¥OU open an account for 5
ML inpust a customer's data
Tput the purchase information,
d print any number of Saj; TEpOIts, grouping and arranging
» 5 and Products tables to analyze
y or monthly sales in all kinds of combinations.

5ks s to open existing darabase or
e Database from available database templates categories. As
Education Templates database for aur

- This feature is
Values appearing

I RO
LR

Fig. 1 : MS Access Database Tampolets

Area of MS Access

soft Office Button v of the functions that were

A 2 Hlows you
osoft Office Button performs BLC  Cryis button
= Ider versi
File menu of o
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to create a new database, open an existing database, save and sy, e
send, or close. ™ Pling,
)
b ) Databasa 1,
== B . 13
| 11 Gt | el 22 [0
L_lews_ Font =
Faculty Navigation. - rhﬂ-'ﬂff v | B S
Faculty _ f grr '
L Faculty Details ' Ly == FaCL
B Foatylst KE‘_TL‘“"T]
,ﬂ All Faculty ; i Faculw I
,.“ Emergency Contact Informati,.. ;New}
M FacutyaderessBook’  fl | Totall
Fig. 2: Niﬂé‘a)liun ;,i'nh ______
5.3.2 Ribbon 3 i
The nbbnn:sthepamsatthtuppmﬁmoﬂhz document It has four
tabs: Home, Create, External Data, ar d Dsl;iba.ae Tools. Each tab is divided
into groups. The groups are logical collections of features designed to per-
form function that you will utilize in ¢ evelopis 2 or editing your Access data-
R : Fig, 4 : Use of Arrow on Groups
L PR 1 Records, Sort & Filter, Find
o e Views, Clipboard, Fonts, Rich Text, Reco
R i ] o Tables, Forms, Reports, Other ot
E:_i : S id AR e ﬂ ; fernal Data : Import, Export, Collect Data, SharePoint ![.].:-sb‘ﬁ”mh
Sl s 'IaeTuuls Macro, Show/ Hide, Analyze, Move D, L
Commonly utilized fea s ¢ ddi- tains commands
tional features within ead\ g b&"‘ L .‘”IT :m.,-: izable toolbar lw;:n Ibar above of
ttom right © lace the qmckacc lick on
Of eﬂCh gfoup 4 p k ACCESS I,Oﬂlbﬂfac
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. Facuity by Type t S mm‘wn

I: ltm

- lﬁ&s:Mku Toolbar
5.3.4 Navigation Pane = :

I The Navigation Pane

rien and peperii R e stahase

objects such as tables, = 4

ot Window Vi@wihg 275
document viewing open,
¢ window. Click the Pens tables,

forms
tabs o swircl, ™

mw“"" ‘\E«L:::I:hz“d Tepors in
- H' IMM:M“‘““'M% 4 fao
Faculty List

GpCollectDats  8faadbrmr

o

(e T T

LE]

Fig.7 : Tabbed Do
sing Access

2007 offers a wide range of customiza
ess work the best for you,

ment

. :
- ol oplions that allow vou
To access these customizable options:

Recent Documents
1 Faru™ stean
4 Daamaies aeds

3 Database? azeds

4 Dalabate

§ Contactil accdh
& Databatel arcae
7 CatanaIed.atcen
& Contactsl.accd

@ teitacede

| Qlose Database

._——-’ i ] Lok Dpliond W, Eak MLk
; : Fig, 8 : Office h:tl:n\mi::spe
1 -E“ﬂ'mé“;ﬁ;fgﬂﬁfg: {he location and file format of
 and the username.
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5.3.5.2 Current Database : This feature allows you to set options for the

Application, Navigation, Ribbon and Toolbars,

, AutoCorrect, and Filters,

[
B
= -
| P

: 277
oy [ |

i

= e L
it Dpegme =
| o L P
Py -
| 15 SIS =
s maied | Kol
LRl LT
P
ey
B
B Lesiee B et s,
Fasasm

Spt e shg
o d

] T
: -
- ‘._‘.- :_“- o
Fig. 11 : Datasheet Optio:

Mo bject Designers : This feature allows you to customize the op-

ting and modifying database objects in Access including Table
ery Design, Forms/Reports, and Error Checking,

-

nalize options in the
ines and cell effect:

142

. ==
Fig. 12: Object

Designer Options
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allows you to change how Access ayy,,
ts of the

5.3.5.5 Proofing : This features
matically correct and formats the conten
cates errors.

database and how it ind:i-

|

oneatngn | m--uunmuwumw
ez [ hpston wirds i LPTERGASE

Custwmazy 1S ot mandi Bt chnbint ATy

L3 Ell-l-wlﬂtllm

) P eeraied wa
Feer (0] ety pirentnd meperchis s French
Eepman | | ) tepaemtrem s dmsndey SAY

e

4

Dgereses g Ergmee Aat)

ST e e e L oma ]
. Fig. 13 : Proofing options
5.3.5.6 Advanced : This feature allows for advanced customization of
Access including, Editing, Display, Printing, and other advanced options.
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€5 10 the Quick
fequently, vou may

7 Customize : Customiz,. .
solbar. If there are togls g
add these to the Quick Acep

ows g
FOU to adg ¢

; teatur

Vi) ili

70 are utilizing ¢

%5 Toolbar, ’

lg"l Coritermaze e

ShaBiE faFmanas fise

Fopwin Dgmmpmg

W

“F Dredtatedni
g Fam
W

o Sane Stas e

¥ Impon e

W e

Fig. 15 : Customize options

s Terminologies

we create a database, we storé our data in tables —subject-based

t contain rows and columns, For instance, you can create a Contacts

ore a list of names, addresses, and telephone numbers, or a Products
store information about products. .

table is a collection of information arranged in rows :?jn::;::?;:;
about an item s displayed i & e Cu!u:;ms f:u:u that tells you

ormation for each item. The table has a header ¢ 3

: H & columns. o i
;ﬂontamed I;it: many tables, each storing mt’uf‘mamtnlabﬂui:f
database can con ’ contain many fields of different FYpes
nt subject. Each table can ¢ .53
ich s text, numbers, dates, and hyperlinks:
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Each table in Data base consists of Records D;ndeiEES

Each Record contains data about one instance the table subject, sye,

particular employee. A record is also commonly called a row or an im‘:;:
Each Field contains data about one aspect of the table subject, sy, ,-

first name or e-mail address. A field is also commonly called a column g -

attribute. an
A record consists of Field values, such as someone@example.com., Nag,

of person or organization etc. A field value is also commeonly called a fagy
Because other database objects depend heavily on tables, we 3h0u.ld

always start our design of a database by creating all of its tables and the;,
creating any other objects. 2

OrEIcE MANAGEMENT To0L3-Copy; 10

(& gy
S Faculty List : =
e e I R L R

B s D - b« Uihome + Lmelatens  -| heeabhess o Cipsiment Vecwny
% d‘" P Tarm L ) (s i ’==-'-H:'| e
ot ' : -+ g -
Fig. 16 : Table in Access
To view data in a table:

*  Click the arrow to open the navigation pane
Double-click on the table name to open the table

Elmrgenq.tmld_ i
Faculty Address Book

ey .vl.-l"l...-.l._L ™
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calculations and display the results. The resulting collection of
called a dynaset (short for dynamic subset), is saved as a database
'apdﬁm therefore be easily used in the future. The query will be updated

sr the original tables are updated. Types of queries are select
that extract data from tables based on specified values, find duplicate
; that display records with duplicate values for one or more of the
od fields, and find unmatched queries display records from one table
o not have corresponding values in a second table.

105 are the second structure in Access. Tables hold the information,
contain stored questions.

ry Types

| Microsoft Access supports many types of queries. Followin
major categories:

g are some of

" ® Select Queries: Retrieve records or summaries (totals) across records.
: Also includes cross-tabulations.

b . Make Table Queries: Similar to Select Queries but results are placed
] in a new table.

i e Append Queries: Gimilar to Select Queries but results are added to
' an existing table
i i i is used to make
L] date Queries: Modify data in the records. It is used to
:‘}};ngﬁ 1o the table data in one hit, rather than dealing with the
records one by one.
s Delete Queries: Records are deleted from a table.

Other: The other types of query {Union, Cross-tab, Pass-through and
Data Definition) are for advanced use, Access provides two primary
e 0 SIS select queries — the Query Wizard and the Query
Designer.

To run a query:

e Click the arrow to open the navigation pane

Double-click on the query name
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sl R piren
Record set * Fig. 18 : Query Window j
A record set i i
. ““‘q“ﬂ?rmnmmbhh‘dm”mwﬂmdsmamhm
S’HFM
A form is a . g
Forms can be | h'-‘tﬂ'fm that is used
o S B e oy o0
: ; *.d : include
h‘mlmum ii hat : 3
B Hall Serves

1. Te a]]wmh :

3. To allow users a method By i
of A : ;
you may create a form navigating through the
run, etc. € -hﬂﬁamm%,ml F":”"“P‘:;
You can view all of your form e ioh et
Tﬂﬁmdahnsinsahm i hm%ﬂmm
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3 l!mw to Upe“ the m‘-'iga.llan pane
Aick on the form name
Lon I aacty T Eveannny Contactintarmit (1) Facutyggenss sk

' Faculty List

3 Friuity Queny

Fig. 19 : Form Window

-"' report is an output of data arranged in the order you specify. Reports

an perform calculations and display the results. A report is an object of Access.

used to display your data inan organized manner. Reports can be used
data

view data using a form:
ick the arrow to open the navigation pane

Faculty by Department
=" poutty B Ty T oy e P Lomad bkinr
Iomas bet. L _u
sl M oA
S i
—_—
Fig, 20 : Report Window

5.5 Creating 2 New Database
B mm———
’ reate a new database from scratch or you can create a database

can ¢
e wizard.

from the




-r1cE MANAGEMENT TO015-Coyyy..
284 R OTF[CF _.\ (.Ulu._ lu{)

285

5.5.1 New Database

f
To create a new database from mtﬂh— “
o Click the Microsoft Office Button Blank Database |
® Click New ) i
# Click the New Blank Database icon Create a Microsoft Office Aozess databace that coes i
.-_,;} A0 e - Sl A0 nott cantain any exstng data or cheste, - §
3 & @ @ File ome: !
vt by PEE it Hrverwt o Coriopird
o - e C:\Usears\Vijayta\Documents
g Getting Started with Microsoft Office Accos d
Tacenar :‘_.‘ s 7
b i
b m—dm ; |
: Fig. 23 : Naming Database
%{1 M IJ | i : 1

Fig. 21 : New Database Creation Createing Table

55.2 Database :mplam ¥ i i dd
i 1 Table Views : There are two ways to view a table in Access to a
il create ¥ ta to the table: Design View and Datasheet View,
b a new data ﬁ'ﬂm ﬂ'ie dnﬁabm terr. '
* Click the Mi ,;h Office But plates:

he data types and
Design View you can view all the fields with t

'pﬁms. The records of information that has been added to the database
viewable.

®  Click New
i hwdmmrﬂﬂwhhmmm

‘ Ll '\-‘l-.
kT ” B e ta e
ok B ~ &= 3t
ot m B e R
S o e G R S RN
oy :::n S 1 ‘"‘:_-‘M
Bt 3 ren L) e
Pl
P
L
: % ....:...n
® Type in the name for the '
® Click Create . Fig. 24 : Design View of Table
.

146



OFFICE MANAGEMENT "llggts-(]quu 104

287

| s two ways to add a new field in Datasheet V.. L
New Field Button. sheet View: Add A New

4 a New Field within the Datasheet;
the Add New Field column

Datagnest

m ='TG Winset  SreTioe autoliumber -/ Unique
"'-‘]{' ¥ Gite Farmat  Reaw

| Mew Add Existing Lookup
Field Frelds Calumn *I"*"\"-'.

Fitlds & Calumang

Create Edemnai Dats Database Taols Strobat

] e Fig. 27 : Adding New Field in Table
g Fig. 25 : Design View a 0 add a new field by using the New Field Button
tasheet View you can display the records in a table, where one row

is one record. The column headers are the fields you have defined for g, i e Cier Bieic Button

oose the type of field you wish to add from the Field Templates window

55.3.3 Datasheet : ¥ Fig. 28 : Adding New field in Design view
2 G?Ck the down amoy o, 4 £ : To add a new field in Design View:

® Click Datasheet i T ® Click the Design View button

554 Adding New Fielgy ' | ® Click on the next available field

new fields into a database. New fi
“mﬂwDﬁpvw. ¢ ew fields can

147
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Data Types

Type in the Name of the field ] =
: ting tables, you should define the data types of the tabl
= eme  Geate  BAemaiOata'c*OstabsieTooks - Awobat Dizign y match the tyrp_e of data that will be Eﬂberéci in the field, s
gt I - ., '}nlhw-.ﬂow: = v i the Data Type in Datasheet View:
E ‘}1 N S foun ﬂ E;z" ick the field you wish to define
ity ﬁ:-::r} Suider Test ':F. :;:M" glwuptnmn 1 Pisnl:hn::lt) Indexes e ol the Datasheet tab on the Rib'l:run
it Teols Show Hide k the down arrow next to Data Type
A Tables A =1 ; the type of data that will be entered into the field
Table1 = 1 DataTy l-'-. Tatle Tani; Databaze?
et | nlnm 1.qu " - R AutoNumber !\um OatabaseTools  Aorobat  Datackes
;I TR e A | =P Data Tipe Ted ___- Ungus o2
* _} C W oDsee Foow Tem = 15 Pegurad =2
| L= o | Rbeme Pt
:I. - QR ([ ‘inummr
Jk-] m st Dite Time
i L . ) Curmenty
i : i . e LadTestle
g 1 Adding New filed in Design view - lowotee |
55.5. Dlh'l'ypea * (New) etk
: attachment

When you create a new field in a database you

. ig. 30 Data type of field
: ;  should closel e Fig. 30 : Editing Data type o
type to what will be entered into the field. . Y makcl the dita To edit the format of the data:
Tex Text, numbe: e o L R ) Click the field you wish to define
I::t' é‘t‘é f; or a combination up to 255 | Click the Datasheet tab on the Ribbon
Memo s : : ! i Format
Arto the tedt Fali —m k the down arrow next to Forma
'Nem ' i Similar to the text field, can contain taxt, iy ¢ Tabia Tools Da
e :g:nbers. or a combination up to 2 GB of
_data. .
' Data ols Acrobat Datasheet
- MM of data e - malDs Database To ;
_ Date and Time information i Ly % insert  OstaType: Number -« T Unique
& : y =
~ Currency up to 8 bytes and precise to 4 i [ s Requive
.~ decimal places

' E Gsiiedp Format:

- fecess creates a unique number for each B " lirename | $ % Gener! Number
" EW record. This is often the primary key

for the table

[ iy ''es and No, stored as -1 for yes and 0 for
OLE Object e AL el

- ges, documents, graphs upto 2 GB |
pupeiak B Webnddresses 7
Attachment i,

_gocuments, and charts,

&
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Attachments such as ;l'l'-l.gas, spreadsheets,

Eura
Fixed
»  La{standard

INEWI' | Percent
| scientific

Fig. 31 : Editing format of Data type
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To edit the Data Typein the Design View:

e Click Design View
e Click the field name
o Click the Data Type
# Choose the a

Format the field in the Fiel

yuuwishlndsﬂnemmteamﬂeld

=ikl

Opc MaNAGENENT T0013-Cany o

149

291

2 Delete a Table : To delete a table:
the desired database by clicking the Microsoft Office Button and

g Open
click on a table and choose Delete

e

f w0 E
s
o= Home | Credte  EdernalDats  Datasase T
\ @z * Calian 1
'u'uf-:.- Faue ';- B 7 P A2 g =
_Miews  Clspbosrd ™ Font
{ Al Tables v o[ I Tablel
Tabiel & v} e
T TooleliTable .. % (e
& Goen
Wl pengn v
[mport ¥
Erpont r
\ % Ceflect and Uedate Caty g Eomadt
Renazme
Hede e thit Sraug
Deebete
|
| <) Geey
.
| =
| 5 Table Propertits
| s ——

: Fig. 33 : Table options
5,5.7.5 Rename a Table : To rename a table:
‘@ Open the desired database by clicking the Microsoft Office Button and

clicking Open
® Right click on a table and choose Rename

Type in the new name
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yTablel . o1 . L IE?_J - o i | K
WL Design Ve mary 1 & unique identifigr ¢
O : : the same for two records. This ﬁeﬁrc:r:g;ord. The primary key
| o i ’ }&E@imﬁ 12 o mm— Dl2rk.
B \a Cefled and Update Data via E-madl | [H:u’-\
. [ R e | g o
Hide in this Group |I g ::ws;‘-—_'n, -
Gk | 4l 28
K i [ Bompd Zagiegs
e B
B S | Facdty I =
{. TR e Drpptess
a;l--".'_.ﬂllttl":‘aj!z. :::‘"" |
: ’(' i e - | hn-:w\ el Degree |
v L |
~ Fig 34: Renaming a table Sehsa Pagran Hamy |
5573 Add a Description to a Table =~~~ § . '
Tﬂmadﬁcﬁpﬁm toatable . ... I | ] ) ¥
® Open the desired database by clicking the Mi : : Pri
clich g - by clicking the Microsoft Oﬁxe_ﬁuhmw Fig. 36 : Primary Key
* ih !I Ay g

Right click on a ta
® Click ﬁlﬂmipum

n-m-' .: S i . -." ¥ b
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Campoeibe Key

A composite key is a primary key that is comprised of two or more fields.
also be called a compound or concatenabed key,

Foreign Key .

A foreign key is a field or combination of fields that are related to the
primary key of another table.

5.7 Relationships

? Table relationships are the associations of data between tables. By defining
 table relationships, you can pull records from related tables based on matching

L

o

Fig. 37 : Table Relationship



wfgﬁﬂj(mm‘cmn
: ¥ R : lnh

A one-to-gne relationship is between two tables where the py:

in one table and the foreign key in another table are the Sﬂmil_-]?a'lf ky

: mpordmﬂaﬁulhble,ﬂmiﬂsmgle matching record in the*tun?;‘th
. : . 8

Summeraddr,
&
i %10 -

Studentingg)y
‘Summgrsu“
1,
. Summerciw e,
% Summerstate
7 SummerZip

5 Flg.ﬂ:'m-ﬂne Relationship
" 5.720ne-to-Many Relationship
A one-to-many relationship occurs between two tables where

= 2 1 ll'ﬂ I.
~mary key in one table can be duplicated many times in another table &

To create relationshi

' Click the Database To
. ® Click the Relationships
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External Data Ditabase 1ns:
2 = seha Cataiima
’ —
Menu fram Mare i [ T
. [ PR et Sl L T E
oo o Visual & Va0 :
M i
= o} 2] Studentings | " g
H -t HudesaCata J Coursetanly | -*
| G Rl
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Fig. 40 : Creating Table Relationsh ips
k on the Design tab

Click Show Table

L] &
" Creple Eema DMy Dymasase Toz
K Char Lyt T WL e
ARG Bepoa = I5an pa e L=}

i Pl (PPN

Tanis

"H_m:“«. i'__"lw U] sssesatans ' ') Cowselae
il s

Fig. 41 : Adding Relationships
ct the desired tables

Click Add

- Click Close

Tablts Queries Bath
e
11
o ) o=
Fig. 42 : Tables

e Click the field you wish to create a relationship from
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e Drag it to the matching field
e Click Create

in the other table

! snedentData CourseTable

R R im
Lait Hame Courie Number
First Hame Course lame
ok
Courgeld

Courskl3

Edit Relationships

:
T
i
"Dleskorcn RefseontlItogrty [creatoten-)
[icascade Updata Relsted Feids
1 ._LCNb-de Disbrn Rebated Reree
[ I'ﬁu: [Ong T .
Fig. 43 : Relating Tables

Print a Table Relationship
® Click the Database Tools tab
® Click the Relationships Button

¢ ® Click the Relationship Report Button on the Design tab
-E"I g _ B w
i:-; g { 2 rade Tae "
¥ Ednt ZyRristioning Repot £= Ovea Ratstionanies

X Relatignskaps ¥

5.8.1 Adding Records to a Table
To add a new record to a table:
& Open the table in Datasheet View
# Click the New Cell

~ Type in your new record
' S Sy o e—m e e L
] hhrm;m
= mm

Fig. 46 : Adding New records

5.8.2 Find and Replace

To find data:
Click the Find button on the Home tab
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h&mymmmrduﬂgfmd&ﬂ*ﬂlaﬁrﬂ'mplmenlgom You have
several options in the Find Dialog Box. These options are:

Find What Text Box Type the text you wish to find
Link in Drop Drop-Down List {Use the drop-down list to specify a tabie
] or a column to search bt
Match Drop-Down List  [Use the drop-down list to narrow down
~ thesearchto a field or the beginning of
_|a field Wi
Search Drop-Down List  [Use this drop-down to specify the
4 |direction to search. ]
. Use this check box to specify whetherto
‘search by the same upper and lower
ase letters,

153
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e totals button provides you the opportunity to add a totals row to
stabase. The total can be the sum, average, a count, minimum,
standard deviation, or the variance. To set up a totals row:

k the Totals button on the Home tab

Al Z Totals
S ;355 g :fr' tp ng
Refrash ey
TR ~ j ars -
- Fig. 50 : Tota tab
p " Click the down arrow of the cell where vou want the totals
'i "' Click the appropriate choice
-ﬁ-—l‘ Iy R -
¥ —— =
G e fan g
t . s -u ESW v® = : o
A B el Sw
_.n.
L e B BRI 203 s = .
,_J Facully List
,' Heatonty CoMeoibespbmsl Lbtbam o ©7
B el = FestNees - 3
I.U-‘l Ayt E

Vg

'-.' o d i

Fig. 51 Application of Totals tab

Bﬁ:l‘d’ rds in a datasheet by a single column or by two adjacent
You can 50

lumin:
records by a single co
columns. To sort

u wish to sort
® Select txg:':; ending or Sort Descending button
e Clickt
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OFFICE MANAGEMENT T001 5.y, i
TR A ¥ "h

h@ I:uum @:@ gii“

ﬂ' X seleqi, e
sHsave W Spelling | - : ' : P
Rel'resh i g Ve Filter EM““U = oo ? Seletion ~
| X Delete - EMore 1 ¥ ¢ Taggs v Speling ﬂ Y advanced
.__EFEPELL“_-; Do Sort 8 Filte - i RN S
r { Delete EMure 2 Toggle Filter
Fig. 52: Sorting Records Sort & Filter
To sort two columns: s R e

e Move the columns to they are adjacent to each other
. ® Select the desired columns for sorting by holding the shift key ang clicks
the columns icking

®  Click the Sort Mcmdi.ng or Sort D&oendmg button

Fig. 54 : Clearing Sorting

ter Records
can filter records to include only records that ¥ou want to display.
by a column:
n the database in Datasheet View
ck the down arrow in the field label
se the appropriate filter criteria

“ﬂ Save “ SP!lllnt
| X Detete - S More -

" (g Faa:ull:w_n,lr List

Mew Faculty ColectDataypa Bomad  Addifre emQutieck  radior Beports

? !}_ 1D - FaouhyiD - FistHame s Lasthame - Emad Addie
1000 Ashish |4} matarez I

5 10 Vijayta Il snzea ¥

Lyl y T

! Total 1 Test frlkers .

 List

SN I-«qﬂi
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...... H l‘k]
To remove a filter: ! o 303
the field labe xe
® c]wk'!hz filter button on i :_e_rnuu Atrabat

Filter
L ] ﬂl;::ggm + IJPHIRLP” b2l =5 2 Wbl = 5= ;
o Cl sl == b L Omare 87 ] 1 ] A0 )
toia Emoil m&umﬂminnk E-mailList Reports :' o Tatioreroms - gz "% 1 prpr 1 2508 Qe Quen 1oz
Folid izand Decge

; “ﬁm:elm beén girablad Qamans

SortAtoZ o i
SortZtoA [ Fig 57: Query Wizard
- ~ @ Choose the type of query you wish to run
. Click OK
&
v Simple Query Weead |
Crosstab Query Wizard
Find Dupbcates Guary Wizard
Find Unmatched Query Wizard

P EHIRE  B e B SR

R

=

Fig58 : Query Wizard
& Choose the fields you wish to include from each table
e Toselect fields from different tables, click the Tables/Queries down arrow

o Click Next
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Tmr.._u

£ R “

Hg.i&:qﬂﬂ!:'_mdol’ﬁ“m
e Typeinatitle for thequery
o Click Finish ) ;
The query will display

W&n&,i T Nvﬂﬁﬂ'ﬂ'“ﬁﬁr‘lf -

'“mmmmhmw
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h between tables and querj
sen the Navigation Pane =

Facultyh!a'ngatml'l""-_-—l:v =
Fa(“h’ A :

a Faculty Details 5 1
,.EI Faculty List !
e }

e S LR e

All Faculty

Emergency Contact Infarmati..

B iE
.y

w

Faculty Address Boak : *
Faculty by Department :
Faculty by Type
Faculty Phone List

| Supporting Objects ¥

Bkl

Fig.61 : Navigation Pane

g 2 Qnery Design Features

* You can also design a query with the Query Design Button. To design a
ery using the Query Design Buttor:

Click the Query Design Button on the Create tab

0 EIDT © Din SRS
I S L, ﬂ"x_"‘“"m'm‘?&h

= Fig.62 : Quwr Mms Feature
.. A q ik e tables that you would like to query

® Click Add

5.«
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Fig, 63 : Tables in Database

Cl]hl:_ “*I

o Double click the name of the field you would like to query

Repeat this process for as many fields as you would iike in the query
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Myt Results

@ Security Warning  Zartain EORtENT (A tha

Home

i ! "hé?i -—! :}'! ? 5

View  Run
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Create Etanal Data
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Tagls T

Fig. 65 : Executing Query

Query criteria are search conditions used in a query

Malue”

e
i
<=
==

>=

le>

Between X And Y
Is Null

or

t

Not

% h e to retrieve specific
data. You can set query criteria to be a specific number
can set the criteria to be a range of data.

or data set, or you

Will only display tems that are that exact
value (replace the word value with what you
want to search by)

Is equal to

Less than

Less tham or equal to

Greater than

Greater than or equal to

Not equal to

Within a range (replace X & Y with values)
Null values

True only if both conditions exist
True If either condition exists

True if the single instance is not true

Table : Query Criteria

= B o
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pedfyuath#'m"' .+ 1o add condifions
':0 sCIick the query M?w:u:;'tzmria in the Criteria Boy
o Type in the app 2

culateing Fields : _

5.9.4 Cal 8 gets its information from the ¢y

A calculated rmldﬁ:a:ﬁ;ﬂgﬁ calclated filds i the 1':;!‘«1%

peﬂomﬂﬁ*:}"jrm (+), subtraction ) multiplication (*) ang ™l :,":"a
using ;

- w a mmbm&tlonof fmhmr field names, numk 7 MLW

e To build al:,ﬁmﬁhﬂwcmua calcuhtﬂd field:

L

Ty or start a new, query
o Clickon theViewBution ~ °

@ Inthe
the calculation
® Click Build
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——

StudentData) £ Totals
| | Table Hames
Cut

Copy

=

Paste

Build...

O & o~ B

| Zoom..,

Fig. 67 : Adding Expression in Query
Choose the tables that you wish to build the calculation from
Double-click the field that you want to include in the calculation
Click the operator that you wish to include in the calculation

Click the second field you wish to include in the calculation
Click OK

Expression Builder

[Course]|[10] + [Course]

Fig. 68 : Expression builder
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" Click Run

] Security Warning  Certain content in the datahase he

Fig.69 : Executing Expression
The Zoom Dialog Box allows you to
time. To view ﬂl&meDm]ossz ¥iw an eviire

® InDesign View, right click on the field
* ClickZoom

expression as Ohe

you want to display

Totals
Table Names
E&-— ——
Copy
Paste
puid..
LS.

RoOPBD

Poperes.
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allow users to perform data entry. Data can be inserted, updated, or
ed from a table using a Form object,

allow users to enter custom information, and based on that information

orm a task. For example, you may want to ask a user for parameters
g running a report.

allow users a method of navigating through the system. For example,

may create a form where a user can select a form to load, a report to

can view all of your form objects in the Navigation Pane. To do this,
on the Navigation Pai.e menu and select "Object Type” from the popup

Forms allow you to control the look and feel of the screen for the input of
‘and the reports generated.

1 Form Views
" There are three ways to view forms in Access:

~Tallows you to design a form that includes a 5
ign View header, a footer, and details in the form. You can

also add images and control which fields appear
!nn_the farm.

orm View This is a dynamic page which allows the user to
enter and edit data or navigate through data in a
ﬂeﬁd.

You can create a form from a table or a query. To create a form:
® Click the Create tab

Click the Form Design button

m WWI Auubnt __F_a_rmat
% ) Symeon, =
; Dm Form
e @ Mere Farms ~ Jﬂl.:.
Creating Form
- .
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i A . -
s Click tleou.-matlﬂb Fields Bufto AL | Sriemantrpe Sedion o
o Click the Add Existing I dlckﬁ"d drag the fields yoy woulg . S8 R v
1n the Field List box on the the right ke e [Fonr s [ (o 3|
on the form i N . :;;"! iy
i AR | Buek corce -::";, Eanz v
=1 3 —
nﬂmﬂ‘l" sarotat 'I'“‘"‘Lwﬂ" T | inemaepiel  guromne

’E

mlmum

AdsHogh  Actess e Colors
[GmGrew W EN N EN
]

[ Sk FEEEEE

MW.'.NH
| Geep Togatne

| Foreepos pa; N EEEEEEY
Hew Bewr O ¢ &

EREER
EEY FEEEEN
Revant Cokors
B
Mare edeet
e 1l . b Fig. 74 :Colour Flate
. - Topreview the form:

® Click the Views button on the Home tab

& Click the Form View button

~ Fig 72: Field List
bﬂue' colors and fonts, click the Property Sheet button on
ge ta 3 Fod

Fig. 75 : Form View

5,10.3 Form Wizard
You can create forms with the help of the Form Wizard. To use the form
wizard:

& On the create tab, click the More Forms down arrow

| - A O
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@ Choose the Tables/Queries that you wish to have on the form
e Choose the fields you wish to have on the forms
o  Click Next :

161

® Choose a style
® Click Next

‘Form Wizard

i

o= (%) Gt
™= ) Tabder
= = |
- ,J'. l::l

i
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[ Conce -“_“Iiﬂ -L ents || Eege

Fig. 78 : Form Wizard skeps

) e )

Fig. 7 Foem Wizard sitps
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. Createaﬁﬂef“"wm
e Choose whether
foml'sd.eﬂE“

ot

pur wmtwopmm form to view it or qui‘y the

; ; Hg,ﬂll' BunnWimrduhps
5J1Reports
Re_pomueammstowﬁmdamlyml&rge amounts of data. You

1, modify or delete
port but you cannot
_i'l the I:ables associated with | 1

 allows

u'

!-'

m view the data from the
 any layout of the report: .

B __-tl'-" see data fromthe table
'Hllﬂidelate con'pnnents of the

l'lllted.

HIFES

RS e
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5.11.2 Creating Report
" To create a blank report:

317

i c:llck the View button on the Home tab

wy
Giam.e. teme  Create. - Bdemal D
I —F
Brui g
E=EEE g

Font

Fig. 81 : Report Views

Click the Blank Rep-on button on the Create tab

v

. — s >
M ey "":.-

me E%-D_ﬁ, ;1 Igm, af

um Fom  Rems BMM Dnlr'l ﬂmmw
i FemeTip L | e e L

Fig. 82 : Creating Report
e Click the Add Existing Fields button
From the field list, Click and drag the fields to the report

- s |
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- J—— | Which felde de you wertt on your regor

- o __;i:
=y . s =&

'-:Egig-.snmnﬂm RV B .___v
Student ID Humber E
Last Name

| You can chooss from more fhan one bl or query.
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[ tiext » ” Exxsh

]

Fig. 85 : Report Wizard Steps

- . Choose the sort order for your report

_Report Wizard

| Wit et onder o you want for your AECords?

] ou can sort reconds by up o four ek, I ether
| aacendng or desoncing order.
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e Chose the layout for the form
o Click Mext

t‘f""wmhmm
iﬂ Saentinfoi

Thats all
—— hmumdmhmm

. Fig. 89 : Report Wizard Steps
Custom Calculated Fields

can create reports that include calculated fields. These reports will
ly information that you wish to report with an arithmetic calculation.
d a custom calculated field to a report:

n the Report that you wish to add to :
the View button ’
k Design View

Layout View
ot RL oot
form's design ctom Calculated field

Hiunrl ALY . ; Adding €
e Click Finish Fig- %0
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Fig. 91 ¢ Desing button window
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ACCESS
pp e

Click the Data tab
- Click the three dots next to Control Source

Textd
| Rasport. Header

(PogoHeader

323

b
ne =l
—___h i.T:
Plain Text

| _Paste | neb |

v CNalue> ~
AfterDelConfirmEmt
AfterFinalrenderEn
AfterInsertEmMacr(
AfterLayoutEmMact
AfterRenderEmMac

AllowR epartView
v AutoCenter v

Fig. 93 : Inserting fields for custom calculation

® Insert the fields you wish to include in the ca
upemh:ms
& Click OK

Iculation and the mathematical
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Expression Builder

'ru}(m Nema] e _
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Fig. 94 : Expression Builder
5115 Printa Report - -
© After you have generated a report, you can print the report. To prin the
Print a Report
" To print a report: <~
e Select the report you wish to print

Close All
8@ | Report View
Layout View '

Eésign\rlew

OrricE ] \[A_.\AGI MEE \'I T(}()I.S Cong 10,

AR R R R
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Flg. 96 Pnnhng 'Dphans

e Click Print
¢ Click OK

Fig. 97 : Printing Report

Exercises

Very Short Questions (upto 20 words) (2 marks each)

--'&; 1. What do you mean by Table?
2. What do you mean by Report?
' 3. What do you mean by Forms?
4. What do you mean by query?
?&‘ 5. What do you mean by Relationship?
: —
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6 What do you mean by Sorting?

7. What are the types of Query?

8. What are different views of Forms?

9. What do you mean by field in database?

10. How many types of keys are available in MS Access?

Short Questions (upto 80 words) (4 marks each)

1. What are the types of relationship?

2. What do you mean by data types of field in table of MS Access?

3. What do mean by property sheet in Forms of MS Access?

4. What is the role of Report Wizard?

5. What do you mean by Database?

Long Answer Questions (12 marks each)

1. What do you mean by MS Access? Explain its use in Database?

2. What is the role of query in MS Access?

3. What is role of tables in database? How will you create tables in MS
Access? -

4. What are Forms? How will you design a form in Access?

5.

What is use of Reports? How will you print report as per user
requirement?
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